
Change History

Following is  a  detailed  history  of  FileList+  versions,  starting with the oldest,  up to  version
1.0b21.  Note that some items are changed more than once, so that only the most recent data
applies.

•••••••••••••••••••••••••••••••••
New to version 1.0b2 of FileList+
• Version 1.0b2 added the option (see "Scan Options…"  menu item) to get version number

information for applications, INITs, cdevs, and system files.  Note that not all  applications
and the like contain the “vers” resource used to obtain this information, so that some will  not
return a value.  Also, files that are compressed in StuffIt or Compactor archives are  beyond
the reach of FileList+ and will not show any version info either.  Note also that  this slows
down the scanning of disks, particularly if the volume contains lots of system or application
files.  Default for this option is OFF.

Addition of the version number information required changing the file  structure.   Therefore,
FileList+ version 1.0b2 will read all older version FileList list files, but will write a format
incompatible with earlier versions of FileList and FileList+.  The save as old format does not
currently convert back to the older format. There is one known bug/feature in the version
stuff.  Under MultiFinder , the current Finder and MultiFinder files version information are
not available.  An error code will be indicated instead, as in “n/a-193” for error -193.  No
bombs or other distasteful stuff accompanies this problem so it shouldn’t be a big deal.  I am
working  this  problem.   If  anyone  knows  a  way  to  access  resources  in  active  Finder
andMultiFinder files, please let me know!!

• FileList+  will  now  prefer  the  “Preferences”  folder  in  the  current  system  folder  for  the
“FileList Options” file.  It will alway look there first for the options file and will write any
new or changed options file to the “Preferences” folder, if it  exists, deleting the original
options file in the process.  This is the standard for System 7 and just a good idea for System
6.  

• Version 1.0b2 fixed a bug in version 1.0b1 where 800 Kbytes was used as the maximum size
of a Floppy for the purposes of which icon to show in the Add volume dialog.  1.4M is now
the cuttoff point for Floppy versus Hard Disk icons.

• Numerous other minor bugs were cleaned up.

•••••••••••••••••••••••••••••••••
New to version 1.0b3 of FileList+
• Version 1.0b2 had several rather bad bugs with converting from old to new file format.  
These have been fixed.  Also, Save As Old format menu item will now save a file in the old

format.
• Fixed bug that made Find Volume inoperative.
• Fixed numerous other bugs, some of which predated FileList+.

•••••••••••••••••••••••••••••••••
New to version 1.0b4 of FileList+
• Changed conversion progress indicator to not try an estimate of the time remaining.
• Fixed bug that caused last selected item in Filter  pop-up menu to be selected if  no item

selected.
• Fixed numerous other bugs.



•••••••••••••••••••••••••••••••••
New to version 1.0b5 of FileList+



• In the Files window, user  may now sort  by clicking the header item.  Also,  header will
indicate the sort-by field, if that field is displayed. (1.0b6 added this to Volumes window
also.)

• In the Files window, the user may enter any printable character to select next item with the its
sorted-by field starting with that character.  Does wrap-around at end of list.  List must be
sorted by Name, creator or type.  Case sensitive for creator and type only.

• swapped order of create and modify date items in display options dialog
• Fixed numerous other bugs.

•••••••••••••••••••••••••••••••••
New to version 1.0b6 of FileList+
• Added powerful new menu item “Compare File Versions”.  This function is similar to the old

“Check File Matches” menu item (which has been renamed “Custom File Matching”) but
goes a lot further.  See description below.  This required a file version change.  

• User may now sort by clicking the header item in either window, any field.
• Added reverse-sorts.  To sort in descending order, hold options key down while clicking on

the header or selecting the menu item.  Default is ascending.
• User may turn off the display of any field in the Files window by command-clicking on the

header for that field.
• Renamed menu item  “Check File Matches”.  It is now “Custom File Matching”).
• Sort by match now maintains previous sort sequence for all types of matches & non-matches.
• Added menu item to View-Files menu for sorting by Version and Name.
• Version numbers will be skipped to first numeric character if they are too long for field on

scanning.
• Fixed a bug in the File Filter Options dialog that would not allow the letter “A” to be entered

in the text fields.  Also started checking for valid characters in numeric field.
• beefed up character handling in dialogs to allow use of command-keys or un-modified keys it

most dialogs.
• made text font for printing 7 point. (plan to add user options here in the future)

•••••••••••••••••••••••••••••••••
New to version 1.0b7 of FileList+
• Fixed bug that prevented Replace Duplicate  Volumes option from working for automatic

scans (initiated by the a disk being inserted). 
• Improved “Compare File Versions”.  More log information, better compare algorithm.
• User may now rearrange their fields in either window by clicking the header of the field to

move and dragging to where it should go.
• Added a new menu item that resets  all  (new) options to their  defaults.   Does not effect

options selected in the Options menu item.
• Beefed up robustness of Compare Version.
• Fixed several bugs, including several with new Compare Version function fixed bug with

match - when stripping numerics, now also stripping trailing blanks fixed bug with log file
name not  returning  to  "untitled"  after  "New" entered  problem where  apps  are  not  same
version but create date says they are, check sizes
If  sizes  differ  by  more  than  1K,  then  use  modify  date  to  indicate  relationship  when  an
executable indicates a match but the size difference is  greater than 1K bytes use modify
date/time instead of create date/time or version to relate files (needed because some code
writers i.e. SuperClock, Boomerang, use same create date for all versions of files)



• Made icons in Add… dialog staggered to improve readability of longer volume names
• Added match field to display items, made it independant of name
• Added divider lines to log file 



• Moved Size item in View-Files menu & Display Options dialog to follow default window
sequence

• Added variables to Options file for field sequence, changed version number of options file
• When options file is older version, preserve the window displays
• Added Apply button to Display Options dialog so user can see effect of selection
• Now inverting both sort fields (match and last) for match sort

•••••••••••••••••••••••••••••••••
New to version 1.0b8 of FileList+
• Fixed bug that caused a blank window to appear if no FileList Options file was found at load.
• Changed default list format to use original FileList format unless scan with file version info 
enabled or other operation performed that requires new list format.  The list will be converted to

the latest format in this event.  This change will prevent the display of the 
version field unless the list is of the new type.
• displays command key info for Scan Options dialog
• added options for Exact or up-to-numeric name matches to Match Prefs dialog
• added option for Path to Match Prefs dialog
• clear sorted if sorted by Match and Match data changed
• added Secondary sort for Creator, and Type
• indicate primary sort field with tag in bottom left corner of field header item
• changed Custom Match to only mark the second and subsequent matches
• Fixed other minor bugs

•••••••••••••••••••••••••••••••••
New to version 1.0b9 of FileList+
• Fixed bug that prevented second sort parameter from being performed descended. 
• Added secondary sorts for volume and path.
• when Files window is sorted by Name, Type, Creator, Volume, or Path, entering 
starting string will search that field for next occurence (used to only do first three fields and only

first character)
• cleaned up the Save Text function

•••••••••••••••••••••••••••••••••
New to version 1.0b10 of FileList+
• when click in header bar, shows selected field with gray box
• in compare versions, only show files that pass the file filter in "no copies" list
• cleaned up Log file, made path lines shorter, file references more uniform
• no longer show Desktop files in Log file
• added in-progress dialogs for Sort, Scan and Print operations (print has cancel too!)
• fixed bug with auto-search by type or creator
• changed dialog centering to use active window, not whole screen, good for those with large

monitors
• improved background processing for match functions
• added  check  for  spooling  before  calling  PrPicFile,  might  help  some  reported  printing

problems



•••••••••••••••••••••••••••••••••
New to version 1.0b11 of FileList+



• fixed bug in Save Text (w/Tabs)
• fixed major bug in print (from 1.0b10) that would lock the machine the second time the Print

menu item was selected
• fixed bug with initialization that caused blank windows at initialization if no Options file

found (thought  I  had  fixed  this  problem back  in  version  1.0b8 but  had  an  uninitialized
variable)

• pick up other normal Options from older format Options file, sets other options to defaults
• added status for printing that indicates “Skipping page…” when starting page has not been

reached
• stop printing cycle when stop page is reached (was printing OK, just went through the whole

document anyway)
• speeded up sorts (View-by), especially by Volume and by Path
• fixed sort by Path so that second sort field is actually used, not Name field

•••••••••••••••••••••••••••••••••
New to version 1.0b12 of FileList+
• made sort by path about 25% faster by doing check first for same parent
• added tabs in front of key places in Log file so proportional fonts may be used
• fixed bug with sort by Version, was doing reverse sort for forward & visa-versa
• made active header region (for clicks) not include status
• auto-search will wait for keythresh timeout before starting search
• integrated Find function controls into header bar

added Find First, Find Prev, Find Next buttons
Tab will rotate among find fields
cut, paste, copy work in find-text fields
auto-seach text is entered in current field, based on view-by statu in  Files  window,  search
may be by name or parent or volume
if by parent or volume and all items blank, will skip to next parent/volume

• added Find First and Find Previous menu items (same to header controls)
• removed Find dialogs (redundant to header controls)
• made menu item Find always visible

causes display of Find control items if they are not currently available causes selection of
find text item if currently visible

• fixed bug with Save Text of Volume list

•••••••••••••••••••••••••••••••••
New to version 1.0b13 of FileList+
• fixed bug with incorrect files being labeled as older/newer whenever they where compared

based on dates and more than a few hours different in age.
• fixed bug with filter pop-up menu not working when find controls visible - MDEF not set in

rsrc
• fixed bug in dialog edit items that would'nt recognize delete, cursor keys
• fixed bug w/print bombs in Finder, bumped minimum appl heap to 96000 bytes (was ~30K)
• fixed bug in Options menu item, return was selecting second button (Save and Cancel), now

selects highlited item
• fixed bug in drag field routine that would allow click between header items
• fixed resource SIZE to allow background events, will now operate in background



• fixed bug w/find controls and status and horizontal scroll
• fixed bug with primary "sort by" marker and horizontal scroll
• fixed bug w/options files created where none existed have no type & creator, no icon



• fixed another bug w/no windows when no options file found!
• fixed  bug  w/System  7  and  grayed  default  button  in  open/save  dialogs  changed  find

operations: don't start search over from start just because new text entered
• fixed bug in Add… dialog with mouse click on volumes 15 and 16 not selecting items
• fixed bug where text file default name not changed after new file is opened
• fixed bug with bomb after cancel Rename of volume during scan
• added new option to volume menu and scan options - filter on add

default = no
applies to all add operations

• added Executable File option to File Filter
• added ScanOptions button to Add… dialog
• added cmd-click >> delete for Find Controls
• added options display in scan progress dialog
• moved Automatic, Stuffit, Compactor options to Scan Options from Options
• added new option to Scan Options for Archive Only, only scans files in archives
• added auto-scroll (vertical & horiz)
• added routines for extended selections

changed data structure to use one byte of "kind" parameter for this > changed file version
• added "selected" field to both lists ("•")

field cannot be turned off - but can be moved
selections are saved when file is saved
use shift key to extend selections
shift drag will select all records between drag begin and drag end
added skip to next selected when Enter key hit, go to cursor when return

• added second line to statistics bar, selection info - group, # groups, selections, byte count of
selections
show total free size of selected volumes

• added view "by selected (& last)" menu functions for files and volumes
• added interaction between volume window selections and file window selections

cmd-click in volume window will select all files in that volume
• generalized contrain function w/shift for print, save text will print only selected records
• changed VERSIONF (list file version) to 4 from 3, made this the default version, not older

FileList format, will read old versions, need to Save As Old format to get version compatible
w/all versions of FileList+, FileList

• changed Delete (volume) menu item to Delete All Selected
• added Select All, Find All menu functions
• added Delete Selected Files menu item, changed old Delete Files to Delete Files Special

made delete key sensitive to active window for which records it deletes
added safety option - warn before deletes

• changed Rename to Rename Volume(s), does all selected volumes
• copy to clipboard now does all selected records
• added multiple select groups (5) including present selections
• added Select Menu w/all selection group commands

added push/clear, pop/rotate, add, and, invert, and push/rotate commands
push (shift) and clear present selection group before Find All performed, unless no selections
push and clear does not function when no selections made
added menu items

save (push) selection group and clear present bits
get last selection group (rotate left)



pop last selection group (rotate right)
push present selection group and clear (shift right)
OR present and last selection group (& shift left)



AND present and last selection group (& shift left)
toggle selection group
Select All
Select Special… files are in selected groups (special)
Reset all selections

• added "Print Selected" when shift key down w/"Print All"
• added Selection Groups A and B

changed only when swapped with present group by user or reset by Save As Old
added menu items Swap Present with Group A, ... B

• made cursor selection a rectangle around selected record instead of solid invert
• stopped resetting vertical scroll positions after

delete field, drag field, reset fields, menu routines, reset match flags
• save is always permitted, even if file has not been changed
• added Find All button to Find Controls
• added Non-System files only option to filter

requires records scanned and saved with version 1.0b13 or later to be operational
• added User Selected Records option to Select Groups dialog

applies in addition to match and filter settings, in other words, a file must pass all three sets
of criteria to qualify

• changed default list file format to latest version, no longer defaults to FileList 1.4
when scan is performed, previous list is converted to latest version if it is not already

• show selection stats in printout header
• now warns before converting for Save as Old (all data may be lost)
• only use modify date for executable files wo/version info and same create date and size diff >

1K
• added Finder flags to database (2 bytes after version info)
• changed options file name to FileList+ Options to allow coexistance w/original FileList, user

should throw away the old FileList Options from FileList+
• added font menu items to Special menu, sub-menu items for status, window, print operations

saved in Options File whenever save options is performed
• added option to Options for Save Text/Copy format - same as displayed or fixed no longer

related to Tabs options
• changed fixed format to same as default display sequence & menu sequence
• reset fields to default (command-option click in header) now only resets the window clicked
• added scan option to disregard desktop files (default = on)

 uses file TYPE and CREATOR to descriminate  
 "FNDR" and "ERIK"  or  "BTFL" and "DMGR"  or "DTFL" and "DMGR"

• checks for options file in same folder as application after System, Preferences folders
• when save is performed with only one volume in list and name has not been specified, uses

the volume's name followed by " List" as the default name in Save dialog
• added new Match Preferences option for One Match per File

applies to both matching functions
will only compare files that have not been matched already
useful for audits where only one copy of software is allowed
default is OFF

• added new Match Preferences option for Create Log file for Version Match
default is OFF

• added Selected files only constrain to Custom File Matching
will compare all files, setting match flags only when one of the files is selected



does not File Filter files
invoke by holding shift key down when selecting menu item

• now converts all lists when they are read in to the latest version



• changed match functions to set multiple match flag whenever a new match is found and a
previous  match  was  indicated.   This  fixes  a  bug  where  the  sort  sequence  would  effect
whether a multiple match was indicated

• changed version match function to NOT set multiple match flag for first file
• cleaned up match functions to indicate the two non-multiple matches of a multiple match set

on the correct volumes (same or different).  In other words, if you have two copies of a file
on one disk and other copies on another disk and selected "Different" volumes, one of the
files on the first  disk and one of the files on the second disk would NOT be marked as
multiple matches, the rest of the copies would be.
Before, the two non-multiples could be on the same disk, depending on the sort sequence.

• if sort-by item is the same, but the reverse direction, maintain previous last sort
• increased size of maximum volume back to 4 Gigabytes, files still limited to 256 megabytes

stopped using same format for each, not using match bits for volumes
• using same dialog centering algorithm for Standard File Open/Save as for other dialogs
• moved match statistics to second line of file window only

use p2 size for matchBytes, only count it once (if already matched, skip)
• moved Scan Options menu item to Volume menu from Special menu
• rearranged items in Volume menu
• added Display and Scan options buttons to Options menu item in File menu
• added date, tabs options to those reset with Reset Options to Defaults
• changed defaults for: date format to MM/DD/YY; Use Tabs between field enabled
• fixed bug with files starting with number matching on anything for Match to numerics, now

skip leading numerics.  Effects Match functions.
• now doing push and clear before Select All Records functions
•••••••••••••••••••••••••••••••••
New to version 1.0b14 of FileList+ 7/25/91
• fixed  numerous  bombs  on  Macs  with  68000  when  list  convert,  Set  Custom,  and  other

operations performed
• added cancel button to Scan progress dialog
• indicate in Scan progress when a volume is being replaced, beep
• holding down command key while clicking file in files window will select all records in the

same folder as the file clicked, or deselect all if that file was already selected
- holding down shift-key also will extend previous selection

• added "Item Selected" radio "button" in Filter menu that indicates when any item in the pop-
up menu is selected.

• getting version information from signature resource if 'vers' resource not found
• fixed bug with unmounted volume being remounted by drive INIT
• for Compare Versions, if names, types, creators and dates match but size doesn't, set both

older and newer flags on both files to flag possible anamoly
• fixed compare to numeric so that "Name 1" ≠ "NameMore 2" but "Name 1" = "Name  2v1"
• fixed bug with Find All button not selecting the first record found
• fixed bug where scan and display options set from Options menu item not used
• added option to Options dialog for saving the Select (•) field
• added Save Text progress dialog with options shown
• default  name for Save Text file is now list  file name + " fil.txt" or "vol.txt" for Files or

Volumes window
• when Save is performed, don't deselect current record & don't scroll to end

•••••••••••••••••••••••••••••••••



New to version 1.0b15 of FileList+ 8/6/91
• fixed bug with Options… dialog bomb on Mac Plus, Classic and SE
• fixed bug in delete file records.  It was deleting any selected volume records also!
• fixed bug where Font selections were saved in Options but not retrieved at program load
• fixed bugs with window titles not being in sync for "changed" status
• fixed bugs with editing search values

clicking a menu bar without selecting anything was deselecting edit item was performing
automatic find when name was clicked and timeout occurred while entering text

• added statistics update during extended selection of records
• deleted file records (deleted from files window) will not actually remove data from database

until a Save, Save As, Save As Old Format, scan, or Merge is performed.  Instead, they are
just marked as deleted until one of these operation is performed, or until they are unmarked
by entering the Undo command.

• improved speed of menus
• changed sort to indicate when it uses the Name field as the default secondary sort

(for sorts by size or dates)
• keeping track if version info is present, display field if it is present and enabled, don't display

field if no values present for it in current list, even if it is enabled
• Text  Export  option  Text  as  Displayed worked backwords,  was  using  fixed  format  when

selected, format as displayed when not selected.  Fixed it to work like name says.
• no longer loses list sort when following operations are performed

Rename Volume
Delete Volume
Delete files
Save As Old Format

• added Options… button to Save Text dialog so that text options may be set
• copies text from Name, Type or Creator field in Files list or Name in Volumes list to the 

Find text item of the same name whenever one of those fields is clicked in a record with the
Option key down.  For example, to find all files of the same name, click on the name of a file
in the list with the name you want with the Option key down.  The name will be put into the
Name field in the Find controls.  Click Find All to set selected flag for each of these records.
Use enter key to skip to the next selected record.

• fixed bug with menu items not being updated from find controls for cmd-key entries
• Changed search path for FileList+ Options file at application launch.

When opening FileList+ Options file, looks first in application's folder, then in Preferences
folder in System Folder, then in System Folder itself.  Application folder was last.
When saving FileList+ Options file, sequence is Preferences, then System folder.

• when a scan is canceled, no longer ejecting the disk

•••••••••••••••••••••••••••••••••
New to version1.0b16 8/6/91 - 8/30/91
• changed menu command key for Find Again to command-R and added to command-A for

Select All Records
• fixed bug where window header could be corrupted.
• fixed Compare File Versions to show version number with letter appended as newer than one

without, for example 4.0a is newer than 4.0
• fixed bug with list records being displayed in geneva font when auto-scroll is performed with

the shift key down.
• when all files are deleted from a folder, the folder is now being deleted from the database



also.
• fixed bug where group stack info not reset when list is cleared with New menu item
• fixed bug with save text with selected field not shown causing name field to be copied twice
• added Created date and Modified date options to File Filter
• added Display Option for displaying file size in K bytes

all values shown in Kbytes are rounded up, i.e. 1-1024 bytes = 1K, 1025 - 2048 = 2K etc.
Calculations use original numbers and may not reflect use of rounded numbers.
Note: File sizes do not necessarily reflect disk space

• fixed several bugs with selections
extended de-selecting of volumes was not working
statistics for files window was not updated when extended selections made

• changed cmd-click on file  record to  select  all  files  in  the current  files folder  AND sub-
folders,
was just same folder

• added cmd-option-click (2cd Parent modifier keys) on file record to select all files in the
current files parent's folder AND sub-folders,

for example, a file in the folder "A" which is in the Folder "B" when clicked with
cmd-option donw will

select all files in folder "B", including sub-folders.
The 2cd Parent key(s) must be in ADDITION to the key(s) used to select the parent

folder.
• changed current  version number for  options  file  to  6,  will  read window data from older

versions
and reset other options to defaults

• made all click - modifiers user selectable via the Options menu item
• changed "Special" selection dialog to always allow match flag selection, even when match

info is not current
• fixed bug when out of memory occurs during merge operation, was indicating wrong value

for Get Info application size
• fixed bug where list  file that was shortened will  still  take up same space on disk unless

written to new file,
problem was no new EOF was written after the (shortened) data, leaving old EOF

• fixed bug with font menus not showing check mark if last item in any menu selected
• changed select field - field is now fixed on the left column of the window with a diamond

symbol indicating record is selected
save as text with save select field option selected will place a bullet in the first field output
for each record that is selected

• added lines to Find Controls area and seperating fixed Select field and other, scrolling fields
• fixed bug where if secondary sort was by Select field, header was not cleared when selections

changed
• added command keys for Options dialog
• added Text file Creator option to the Options… dialog - effects both the Save Text and Log

files
• fixed line across statistics and find controls header when activate/deactivate window
• fixed bug with resized windows being messed up whenever Display Options were changed
• fixed bug where font info not being updated when Reset Options performed
• added menu bar item "Sort" to replace both view-by menus, added "Files" and "Options"

menus, moved many menu items
• changed command keys - Changed Find Again to command-G, added command-R for Find



Last, command-U for General Options
• marking last sort by field in menu with a diamond symbol
• fixed bug where when sorting Files list by Path, the volumes list sort was cleared
• speeded up Find All,  stopped showing cursor on each match, return to last selected if no

matches, otherwise, jumps to first match
• fixed edit (cut, copy, paste, clear) commands for editting text items in Find area
• added Tile Windows menu item to the Options menu
• modified Stack windows to set window width for large monitors to a maximum width of 560

pixels
• when options file is  corrupted or a different version than this  version of application,  the

program will put up a warning message and reset all options to defaults
• allow f2-f4 to work as Cut, Copy, and Paste while editing text items in dialogs and search

parameters

•••••••••••••••••••••••••••••••••
New to version 1.0b17 9/3/91 - 9/4/91
• fixed bug that distorted Compactor Archives record data - bug was introduced with in version

1.0b16 by bug/feature of new compiler
• fixed  Scan  Options  to  not  allow  setting  of  Archives  only  when  neither  archive  type  is

selected
• changed Find menu item to toggle display of find controls
• made option to display Find Controls independant for each window, added separate option

for Volumes list
• fixed bug with top line of header being erased whenever statistics updated
• changed Files window in display and print to use Geneva font for Volume and Path text,

overrides selected printer font for that text only

•••••••••••••••••••••••••••••••••
New to version 1.0b18 9/4/91 - 9/7/91
• fixed printing of file path, was positioned too far to the right
• fixed problem with garbage characters after the path in display
• fixed problem with Estimated Time display in progress dialogs
• fixed problem with convert progress showing status of File Filter that is not applicable
• cleaned up conversion to not leave corrupted database if Cancel perform, either clears or

recovers data if possible
• speeded up conversion process by factor of over two
• fixed Files and Volume menu items to enable menu items even though that window is not

active
• changed export text (copy or Save Text) to always use byte format for sizes, not Kbyte

•••••••••••••••••••••••••••••••••
New to version 1.0b19 9/7/91 - 10/7/91
• fixed bug that would hang FileList+ when file saved after deleting File Record(s)
• added error message for aborted read of corrupted archive
• allow windows updates to happen before reading in files on application launch
• fixed bomb-type bug with conversion of a Merged file
• doing updates to windows between each volume scanned
• fixed bug where text entered as program was launching would prevent the Files window from

being drawn completely



• changed code to allow Desk Accessories to be launched during "background" processing
such as Matching files, allow window updates too

• MAJOR NEW FUNCTION! Delete files from disks!
Choose which when Delete Files performed:  Records or Disk Files
if  Disk Files chosen, each volumes selected files will  be counted and the user given the
option to delete them or skip, starting first with mounted volumes, then with un-mounted
volumes
if files are deleted, the records are also deleted, but may be brought back with undelete until
compaction
if the record for a deleted file is brought back with an Undelete, the selection field for that
record is inverted (black background)
once Disk Files are deleted once, they cannot be deleted again
if volume is not currently mounted, the user will be asked to mount it
if selected file is in an archive, it cannot be deleted.  If list has been created with version
1.0b13 or newer, it will automatically skip these and warn user.
files that are open cannot be deleted
user will be warned if an attempt is made to delete a desktop file - if it is active it won't be
deleted anyway
In System 7, files are moved to the Trash, and may be returned to their original locations by
selecting the files and doing a Put Away from the File menu in Finder

- files that are already in the Trash cannot be deleted again
- The trash is not automatically emptied,  so if  you want to recover the disk

space the "trashed" files use, you must do an Empty Trash from the Finder Special menu
- If two or more files with the same name are deleted from the same volume, all

but the first will be completely deleted, NOT just moved to the Trash.
WARNING!!! 

In System 6, Disk files that are deleted are GONE!  They are not recoverable from the
Trash can or from any FileList+ function.

If files are inadvertantly deleted, they might be recoverable with a disk utility like
SUM or Norton Utilities.

• changed Scan… dialog to use default disk ICONs shown on desktop, indicate System and
Application volumes with SYS and APP beside the icon

• fixed bug where cursor not being restored to pointer after Find All with no matches
• MAJOR CHANGE!!  Changed  match  functions  to  mark  the  first  file  matched  with  "•",

second ONLY with "m" (was also "•"), third and subsequent with both "•m"
this allows the User to select only one or all but one of a match set by selecting the "•" only
or "m" only

• ALSO, added option to Special Menu items (Select Special…, Print Special, Delete Special)
to select files only when the match flags are exactly as shown OR when any selected flags
are set

• Added Balloon help for window items such as Find controls, list records, header, etc.
• edit menu Copy will now give error message when it runs out of memory or whatever
• added new option to Match functions - Ignor Names of executables, default is On (unless

previous versions Options file settings used)
when enabled, both Match functions will disregard the names of executable type files for
matching purposes
made command for this "I", changed Same Volumes to "1", Different Volumes to "2"

• made Delete File Records a lot faster
• when error occurs in Scan of an archive file,  show file name, don't  abort,  only skip the



archive
• in Scan… dialog, Scan button is not enabled at least one volume is selected 
• fixed open document when double clicked and application already open, will open it

changed sequence for checking if the user wants to save the previous list first to after the Get
File dialog

• added Scan All menu item and button to Scan dialog.  This will scan all online volumes,
disregarding selections made in the Scan… dialog.  Up to 40 volumes may be scanned in this
way.

• added check for insertion of unformatted disk, call disk initialization if found
• changed Compare Versions and File Filter definitions of an Executable file to include only

files with the correct, executable file Types
• added Executable file Types for printer drivers "PRER" and "PRES"
• when scanning, added option to Rename the actual volume, not just the list volume
• changed/fixed Default Windows menu item to always go back to last windows saved

•••••••••••••••••••••••••••••••••
New to version 1.0b20 11/1/91 - 12/3/91
• fixed bug with non-operational menu item for Scan Options
• added menu item for scanning selected folder (and it's subfolders)
• fixed bug with cancel no working for Custom Match function
• added Scan Folder menu item to scan selected folder only
• made match flag sort unsigned to place no flags first
• made Volume-field display (in Files List) independant of Path field display
• fixed bug with print header using wrong font
• added new option to sort by match index, will group matched files together in sort

only works for files matched by this version (or later) of FileList+
• changed Scan Options dialog to clarify function of Don't Eject option
• swapped items in Volumes menu for same reason
• added option to General Options dialog for performing Automatic resort after Scan, Rename

and delete of volumes
changed up match functions to use common routine

• added automatic sort by match index if no sort previously done, otherwise automatic resort if
sorted by match flags or index

• changed Custom Match function to handle situation where Ignor Names of Executables and
the  file  types  are  not  checked  -  was  resulting  in  match  for  all  files  compared  with  an
executable, even documents

• added more error messages
• fixed bug with Reset Options to defaults clearing the Header bar sort indicators
• fixed bug with moving match progress dialog - wasn't discriminating it from list windows
• changed Copy function to use disk for storage,  allows for copying of virtually unlimited

umber of records
•••••••••••••••••••••••••••••••••
New to version 1.0b21 12/12/91 - 1/31/92
• NEW FUNCTION:  Options Sets

Options Sets are user configurations that are independently named and saved.
These sets  can be loaded by selecting them from the Options Sets menu item under the
Options menu.
Options Sets can be renamed, deleted, and created.  They are saved in the FileList+ Options
file.



Options Sets may be loaded without losing any list data.
• CHANGED how options file saving is performed.  All options are now saved to the options

file found when searching 1) application folder 2) current preferences folder, or 3) current
system folder
clicking on any Save… button (were just "Save") will produce the Save Options dialog

• ADDED support for more than 32K records, up to 1 terabyte of data.  
• ADDED new options to delete empty folders during Scan, and when deleting files
• IMPROVED Scan Folder to allow multiple scans of folders on same volume
• ADDED progress indicator and CANCEL button to Save Text progress dialog
• IMPROVED both match functions to gain speed (about 25% for Custom Match, 10-15% for

Compare)
• IMPROVED search and sort speeds 40-50%, especially text sorting and sort by match index

(65%!)
• added commas to size displays when sizes shown in K bytes
• increased size of size fields to accommodate up to 9 gigabyte disks and 999 M byte files

volumes fields were 8 in table, now 9
files field was 6 in table, now 8

• made  name,  version  and  all  size  fields  automatic  sizing.   Field  lengths  will  change  to
accommodate longest name in current list

• fixed bug where resort being performed after each of multiple volumes is deleted
• fixed bug where modify time of Volume list was truncated one character
• made match field auto-display like version field, as well as size of size & version fields
• indicated options in Scan and Save Text progress dialogs are now dimmed, indicating they

cannot be changed
• fixed bug in  Add Folder  -  when replace  volumes with  same name is  selected,  it  wasn't

working
• improved Scan Folder to not open archives accept inside folder of interest - makes it faster
• fixed bug that would ask you if you wanted to delete files from each dismounted volume

when deleting file(s) from any volume
• fixed bug with ejecting volumes with Desktop Manager INIT active - NOTE: trashed file

(under Sys 6)
are returned to their original location unless trash is emptied before FileList+ ejects them

• added key commands for Scan Volumes window Scan Options button and Eject checkbox
• added option to hide the Time data in the Modify and Create Date/Time fields

use command-T to toggle display of time
option added to Display Options dialog
default is to display times

• CHANGED handling of default windows (Options Set defaults)
default windows are loaded at program launch, from the options file default options set
current window positions and size are saved when Save Options is  performed if  Include
Windows is selected default windows are set if Options Set is made the new default options
and Include Windows option selected default windows may be reselected by selecting Set
Windows to Default menu item under Options menu

• added All button to Display Options that enables display of all fields (same as cmd-a)
• added Reset buttons to Display and Filter Options dialogs

sets options in this dialog to the program defaults (not the Options file defaults)
Cancel will ignor all changes made in this dialog

• in Display Options, hitting Cancel after performing an Apply will now reset Display options
back



to previous values
• fixed bug with "Options file not found" error dialog being displayed off the screen, waiting

for
an enter key (looked like the program was locked or something!)

• fixed minor bug where Sort menu not updated properly after sort was cleared (diamond left
behind)

• change - when a record or file is deleted, the cursor will return to the next file not deleted
• many other minor bug fixes

limited to either requiring all scans of one volume to be consecutive, or renaming volume for
non consecutive scans

• added key command for Scan Folder "~" (shift-`)
• added warning to File Filter dialog when no file types are selected.  This would not select

ANY files
• changed Custom Match function when Ignore Names of Executables set, don't qualify files

with Bundle bit as executable, use types only
• added new item to end of second line of statistics - shows time to perform last sort, scan,

match or save text
• improved estimated required Application size when file is too large to be read in
• resort is now only performed when a match function is performed if the list was previously

unsorted  or  sorted  by match  flags  or  match  index.   If  match  is  cancelled,  NO resort  is
performed

• fixed bug that would offset the field text and header during match functions
• fixed bug with Rename Volume dialog.  Would accept a name if return/enter key pressed

when
name had not been changed.  On scan or merge, this resulted in (illegal) duplicate volume
names

• now saves status of "Ignore Names of Executables" Match Prefs option in the List File
• fixed bug where Compare Versions would skip files that did not match the volume criteria

when
One Match per File was enabled. Ex. matching files A B C & D where A & D on same
volume and
volume criteria was set to Same Volumes.  Compare Versions would match A & B, then
disregard
because volume criteria not set, then stop searching for more matches, missing the A & D
match

• started counting matched files and bytes in CountFlags, whenever list is changed
• added command key for Custom Match menu item - command-K (as in Kustom)
• made Select Files Special same as other "Special" menu items, i.e. w/Only User Selected

Files
this allows one reduce a list by culling the selected file records

• fixed bug where if one file had file records deleted, then was overwritten by another file
without
saving first, flag that indicated records had been deleted was incorrectly set, causing compact
to be performed, and the Undelete menu item to be active incorrectly.

• fixed bug with match functions bumping match index for all •m files
Only limit is available memory for the application 

• fixed menus to be entirely disabled while an operation is in progress (like matching, etc.)
delete during scan will not remove nested empty folders (only the deepest folder)
default for delete empty folders Scan Option is off



default for delete emptied folders during file delete is ON
• added list of files to be deleted when Delete Files from Disk warning is displayed
• FIXED BUG with Printing stopping after first page when match data current
••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••
Misc.
Some of the other enhancements in FileList+ made prior to version 1.0b1 are as follows:
 Changes -
   • changed default text file name to FileList filename + ".txt"
   • changes to the Add Volumes dialog:
- May invoke the dialog by entering key command "`" (same key as tilde).
- changed to (color) icon based selection
- allow up to 16 volumes (was 8 in 1.4).
- shows floppy icon for volumes less than 1.4MB, hard disk icon for larger
- select a volume by entering character shown inside the icon (0-9, B-G)
- toggle selection of all volumes by enter “a” or command-a.
   • bumped (Options file) VERSION to 4 from 2, won’t read older Options files (but 
will replace them), with the exception of window rectangle data
   • added line between stats and header line and inverted header rectangle
   • cmd-P was used for Delete (volume), now used for Print…
- Execute Delete with delete key
   • changed wait loop to 0 from 300
            (fixed problem with slow updates for
            background tasks such as menu clock)
   • changed file structure - 1st 4 bits of old size field as match flags, added version 
info after name.
- Note: FileList+ reads old FileList format but, normal Write format will be 
incompatible with previous versions unless the file is saved file with Save 
As Old Format menu item.
- limits file size parameter to 28 bits (a mere 256 Megabytes, oh well)    
   • bumped List File VERSION to 4, from 1, will read older list files, write newer 
ones if version data collected or compare versions performed, otherwise, still 
writes older version by default. 


